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Упражнение 1 

Обработка на финансова информация в Excel 
 

Цели: 

 Да се разяснят възможностите за  работа на 
финансови функции в Excel;  

 Да се използват функциите на продукта  при 
съставяне на електронна таблица, обявяване на имена на 
променливите и формат на данните в клетките (използване на 
формата валута); 

 Да се представат възможностите  на Excel за защита на 
данните в таблицата за избягване на грешки при работа; 

  Да се разгледат логически функции за управление на 
извеждането на информацията;  

 

 

Ключови думи: Електронна таблица, финансови 

функции, адресиране, защита на данни, сортиране и 

филтриране. 

 

Ресурси: За реализация на настоящото упражнение е 

нужно наличие на PC с инсталиран програмен продукт Excel и 

надеждна и сравнително бърза  връзка с Интернет. 

1.1. Използване на електронни таблици за обработка на 

финансова информация. 
Задача 1 

Да се изготви електронна таблица за създаване на 
погасителен план за заем, като в нея се създаде възможност да 
се променят основните параметри на плана: сумата на заема, 
годишният лихвен процент, броят на вноските. Изчисляването на 
месечната погасителна вноска да стане с функцията PMT (Rate, 
Nper, Pv, Fv,Type). 

 
Указания за изпълнение 

За да се изпълни задачата трябва да се създаде електронна таблица 
като тази, представена на фиг.1.1 (финален резултат на погасителния план), а 
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за коректно изпълнение е необходимо да се създадат формули, както са 
оказани на фиг. 1.2, да се използват посочените в текста функции.  

Параметрите, които трябва да могат да се променят са поставени в 
областта D3:D5. Там се задават първоначалните стойности, с които се тества 
изпълнението на задачата. След окончателното създаване на таблицата, тези 
параметри могат да бъдат променяни и с това да се генерират различни 
погасителни планове: за различни суми, лихвени проценти и брой вноски (или 
комбинация от тях).  

В клетка D7 и в таблицата трябва да се създадат формули, които да 
изчисляват стойностите на погасителния план при промяна на основните му 
параметри.  

 
Фигура 1.1 Погасителен план. 

На фиг. 1.2 са представени формулите, които се използват за 
изчисляване на погасителния план. Забележете, че формулите в таблицата са 
подобни и могат да бъдат създадени чрез копиране (или размножаване). Важно 
е коректното им съставяне в ред 11. След това чрез маркиране на област 
А11:Е11 и копиране в област А12:Е70 мога да се създадат всички останали 
формули в таблицата. Таблицата на фиг.1.2. предвижда създаване на 
Погасителен план за максимум 5 години (60 месеца). Ако се наложи да се 
увеличи броя на вноските (респективно месеците на погасяване) трябва да се 
увеличат редовете в таблицата чрез копиране на формулите. 
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Фигура 1.2 Формули за реализацията на погасителния план. 

Определянето на месечната погасителна вноска става чрез вградената в 
Excel финансова функция PMT( Rate, Nper, Pv, Fv,Type) – фиг.1.3. Тя се 

създава в клетка D7, като включва следните параметри:  

 
Фигура 1.3 Диалогов прозорец на функцията PMT. 

Rate – лихвения процент с който се олихвява кредите. Най- често имаме 
зададен годишен лихвен процент (клетка D4), затова при изчисляване на 
лихвения процент при плащане на месечни вноски стойността се дели на 12 
месеца, за да се определи месечния лихвен процент. Така на базата на 7.8% 
годишен лихвен процент се определя месечния лихвен процент 0.65% или 
0.0065 като коефициент (виж фиг. 1.3).  

Nper – броя на вноските, за които се предвижда да се погаси заема. Този 
брой се задава в клетка D5 и в случая е 60 месечни вноски. 

Pv – сумата на заема, която се задава в клетка D3. В прозореца за 
задаване на аргументи на функцията Function Argument (фиг. 1.3) пред сумата 
се поставя знак минус „-”, тъй като това е сумата която излиза от заемодателя 
(той я дава на заемополучателя). Така изчислените погасителни вноски се 
получават с положителен знак, защото влизат при заемодателя (той ги 
получава от заемополучателя). 
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Fv – в случая остава празна стойност. Тя се използва когато искаме да 

изчислим стойността на бъдещата сума, която се получава от натрупване на 
вноски за посочения период.  

Type – може да има стойност 1 или 0 и указва кога се изплащат вноските. 
1 означава плащане в началото на периода( началото на месеца), а 0 означава 
в края на периода. Ако в тази клетка не се запише стойност, програмата 
приема, че плащането се извършва в края на периода.  

Окончателното оформяне на таблицата приключва със задаване на 
подходящ формат на данните. Годишният лихвен процент (клетка D4) се 
задава във формат на %. Сумата на заема (клетка D3, месечната погасителна 
вноска (клетка D7) и областта от таблицата със стойностите за вноската, 
лихвата, главницата и баланса (област B10:E70) се задават във формат на 
валута (Currency) чрез форматиране на клетка (фиг. 1.4.). В показания пример е 
избран формат на валута – Евро с показване на знака € след стойността и 
изписване на отрицателните стойности в червен цвят и със знак минус пред 
нея. 

 
Фигура 1.4 Форматиране на клетки. 

Допълнително за да защитим таблицата от грешка при работа е добре да 
се защитят всички клетки от таблицата с изключение на тези, съдържащи 
параметрите на погасителния план - клетки (D3:D5). 

За целта трябва да се отключат клетките с параметрите: 
1. маркирайте клетки (D3:D5); 
2. извикайте Home → Format → Format Cells → Protection (фиг. 1.5.); 

3. изключете клетките  (фиг. 1.5.); 
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Фигура 1.5 Параметри на клетките в Excel. 

За защитита на работния лист се включи командата Protection: 
1. Review → Protect Sheet … 

2. въведете парола за освобождаване на защитата на листа (само ако е 
необходимо листа да бъде защитен с парола); 

3. Потвърдете защитата с . 
Въвеждането на парола, както и промяната на настройките на защитата 

не е задължително. То се прави само в случаите, когато е наложително да 
защитите достъпа до работния лист,  за целите които си поставяме в 
упражнението не е необходимо.  

Когато се наложи да нанесем промени в таблицата извън отключените 
клетки (например при добавяне/изтриване на редове в погасителния план) 
трябва да се освободи защитата: 

Review → Unprotect Sheet. 
Ако в процеса на защита сте въвели и парола, то ще ви се наложи при 

изключването на защитата да въведете паролата отново. 
 

Задача 2 – самостоятелна работа 
Направете погасителен план за същия заем, като 

използвате вградените в Excel функции за лихва IPMT (Interest 
Payment) и главница PPMT (Principal Payment). 

Указания за изпълнение 
Съдържанието на параметрите на финансовите функции е 

както следва: 
IPMT(лихвен_процент;пореден_период;брой_периоди;заем) Имайте 

предвид, че в тези функции всички параметри освен поредния период трябва 
да имат абсолютни адреси – например: 

=IPMT($D$4/12;A11;$D$5;-$D$3) 
 

Задача 3 
Да се усъвършенства погасителният план чрез включване на 

гратисен период при изчисляване на месечната погасителна 
вноска. 
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Да се въведат имена на променливи величини в електронната таблица за 
по-голяма яснота при създаване на функциите в Excel. 

Да се създадат функции за проверка на периода на заема за да се 
избегне изчисляване на вноските след изтичане на погасителния период. 

Указания за изпълнение 

За изпълнение на задачата се използва таблицата от фиг. 1.1. 
Допълнително в ред 6 се задава гратисният период на заема (фиг.1.6). Ако в 
клетка D6 се зададе стойност 0, то заемът ще бъде без гратисен период. След 
въвеждането на новата променлива величина е нужно да се промени и 
формулата за изчисляване на месечната погасителна вноска. За целта 
величината Nper се определя като разлика между периода на заема и 

гратисния период. Това увеличава месечната погасителна вноска от 363.25 на 
396.32, тъй като тази вноска ще се прави не за 60 месеца (както е в първия 
пример), а за 54 месеца (60-6). 

След създаването на таблицата може да се правят изчисления за 
различни периоди на заем и различни гратисни периоди. Разбира се е 
възможно да се променят едновременно гратисният период и лихвеният 
процент, в зависимост от политиката на кредитодателя.  

 
Фигура 1.6 Погасителен план с гратисен период. 

За да се подобри информацията в таблицата при създаването на 
формулите може да се заменят адресите на клетките с имена на променливи 
величини, които се задават от съставителя на таблицата. Така вместо D3 може 
да се зададе величината „Заем”, която да се използва във формулата за 
изчисляване на месечната погасителна вноска (вместо да се въвежда нейния 

абсолютен адрес). Задаването 
става в следната 
последователност: 

1. маркира се клетка D3; 
2. отива се в полето 

NameBox, намиращо се над колона 
А на таблицата (фиг. 1.7.); 
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3. написва се името на променливата на мястото на името на клетката 
„Заем”; 

4. Потвърждава се името с Enter. 
Фигура 1.7 Именоване на клетки. 
Така създадената променлива може да се използва навсякъде в 

електронната таблица, където има нужда да се създава формула включваща 
стойността на заема. Удобството при създаване и използване на такива 
променливи, е че има по-голяма яснота при създаването на формулите и 
функциите в Excel. 

Създайте имена на променливи и за: 
 Годишния лихвен процент – D4 – „ЛихПроц”; 
 Периода на заема – D5 – „Пер”; 
 Гратисен период – D6 – „ГрПер”; 
 Месечна погасителна вноска – D7 – „МесВн”. 

Проверката и редактирането на променливи величини, създадени в 
електронната таблица става от: 

Formulas →  Name Manager 

На екрана се показва прозореца Name Manager (фиг.1.8), който съдържа 
списък на всички създадени в електронната таблица променливи. При 
маркиране на всяка от тях, в полето Refers to се появява адресът на клетата, от 
която програма взема стойността за променливата величина. Пред адреса на 
клетката е изписано името на листа от таблицата в който тя се намира. Всяка 
промяна на стойността в клетката води до промяна на стойността на 
величината. 

 
Фигура 1.8 Диалогов прозорец Name Manager. 

Този стил на работа с обявяване на променливи величини е особено 
полезен, когато в една електронна таблица се създават повече листи и се 
изграждат връзки между тях. Променливите величини обаче могат да се 
използват само там, където се изисква използване на абсолютни адреси на 
клетки (пример =$D$7 от фиг. 1.1) или когато се създават формули, без след 
това да се копират в съседни области. Друго полезно приложение на 
обявяването на променливи е в случаите, когато е нужно да се обяви масив от 
клетки. Excel позволява да се обяви променлива, която да съдържа цяла 
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област от таблицата. Това обаче ще бъде използвано в следващите 
упражнения. 

При създаването на формулата за изчисляване на месечната 
погасителна вноска вече може вместо адреси на клетки да се използват имена 
на променливи (фиг. 1.9). Така се постига яснота при създаването, проверката 
и използването на формулата. 

 
Фигура 1.9 Диалогов прозорец на функцията PMT. 

За да се изпълни последната част от задачата е нужно да се създадат 
формули за проверка на въведения период на заема. Първата формула 

включва определянето на главницата към вноската (клетка D11, фиг. 1.6). 
За да се избегне показването в таблицата на главница, когато няма 

определена вноска се прави проверка на съдържанието на клетка B11 
(фиг.1.10). Когато там има стойност 0 (B11=0), тогава в клетката се изписва 0 
(Value_if_true). Когато условието на проверката не е изпълнено (когато B11 не е 
нула), в клетката се изписва разликата между Погасителната вноска и лихвата 
(B11-C11), което е главницата, която се плаща за съответния период. В 
конкретния случай за ред 11 в стойността на клетка D11 се изписва 0, тъй като 
това е първия месец от погасителния план, който е в гратисния период и не се 
изплаща погасителна вноска. Когато тази формула се копира по-надолу в 
таблицата – в клетки D12:D70, ще има случаи, когато условието на проверката 
ще е изпълнено и стойността на главницата ще се изчислява като разлика 
между вноската и лихвата. 

 
Фигура 1.10 Изчисляване на главница чрез условния оператор IF. 

Втората логическа проверка се използва за определянето на 
погасителната вноска за съответния период на плащане (клетка B11) и е 
усложнена с това, че тя включва в себе си едновременно две, алтернативни 
условия. 
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Фиг. 1.11. Изчисляване на вноска чрез условния оператор IF. 

Когато номера на вноската в таблицата (клетка А11) стане по-голям от 
зададения период на плана (посочен в клетка D5, респективно променливата 
„Пер”), тогава не се посочва погасителна вноска (А11>Пер) фиг.1.11. Второто 
условие се отнася до гратисния период на заема. Когато номера на вноската е 
равен или по-малък от Гратисния период (А11<=ГрПер) в клетка B11 също не 
се посочва погасителна стойност на вноската. Алтернативата на едното или 
другото условие се посочва с оператора (OR - или). Така създадената формула 
се копира в клетките B12:B70. 

Логическият тест връща като резултат TRUE (истина), когато едното или 
другото условие е изпълнено. Това става, когато формулата за изчисляване се 
намира на ред от гратисния период (номер на вноската по-малък или равен на 
6 в нашия случай), или когато реда е след погасителния период (номер по-
голям от 60). Така създаденият Погасителен план може да бъде разширяван и 
за по-дълъг период чрез копиране на последния ред с формули надолу. 

1.2. Обработване на финансовите данни - масиви от данни, Sort, 

Filter. 
Задача 4 
Създаване на таблица за изчисляване на стойността на 
материалите от склада, изчисляване на данъчната основа и 
данък добавена стойност (ДДС). Използване на функцията 
Round за закръгляне на резултата. 
Сортиране на таблицата по един и повече критерии. 
Използване на възможностите за филтриране на данните в 
Excel. 

Указания за изпълнение 
За изпълнение на упражнението е необходимо да използвате файл У1-

report.xls, който се получава от ръководителя на упражнението или се смъква 
от Web страницата на дисциплината (http://fbm.uni-ruse.bg/d/ist2/). Файлът е 
извлечен от база данни, управляваща складовите наличности на реално 
съществуваща фирма. Такива или подобни данни са налични във всички 
организации използващи софтуер за регистриране на складовите наличности 
(„складова програма”). Файлът съдържа таблица с попълнени четири колони: 

 Номер на стоковата разписка, с която е изписан материалът от склада; 

 Дата на изписването; 

 Номер, под който се води материала в складовата програма; 

 Вид на материала - описание, количество, което е изписано и единична 
цена на материала. 
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За да се изпълни първата част от задачата е необходимо в таблицата да 
се добавят допълнително три колони, които да включват съответно Стойността 
на материала, Данъчната основа и Данъка Добавена Стойност (ДДС) фиг 1.12. 
Формулите за изчисляване на стойностите във всяка колона се създават както 
следва: 

 Стойност на материала = Количество * Ед.Цена * 1.2 
 Данъчна основа = Стойност на материала / 1.2 
 ДДС = Данъчна основа * 0.2 

 
Фигура 1.12 Обработена таблица. 

За да се избягнат проблеми със закръгляване на стойностите е нужно да 
се използва функция Round, в 

която освен формулата за 
изчисляване като параметър се 
задава и броя на цифрите след 
десетичния символ. В този 
случай 2, което означава 
показване на стойността с 
точност до стотинка фиг. 1.13. и 
фиг.1.14  

                                                  Фигура 1.13 Функцията Round. 

 
 

Фигура 1.14 Обработени данни 
Тук следва да се отбележи, че стойностите в таблицата са показани в 

„суров вид”. Това означава, че на фигурата са показани самите формули, а не 
резултата от изчислението им (виж клетки G2:I12). Освен това въведените 
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цифрови данни се показват като обикновени числа, без да е показан формата 
им: колона B съдържа пет цифрени числа, които в същност съответстват на 
дати, а в колона F цените на материалите са показани без знака на валутата. 
Например числото 38787 съответства на дата 11-03-2006 год. 

Този режим на извеждане на информацията се включва от:  
File → Options  →Advanced → Display options for this worksheet (включва 

се опцията за полазване на формулите на екрана ) 
фиг.1.15 

 
Фигура 1.15 Прозорец Options. 

Този режим се използва, когато искаме да проверим формули или търсим 
грешки при тяхното съставяне или копиране. Изключването му става по 
обратния начин. 

 
Преподреждане (Sort) 

Втората част на задачата е свързана с използването на командите на 
Excel за преподреждане (сортиране)на данните в големи таблици по един или 

повече критерии (команда Sort). Тази команда е особено ценна при работа с 
таблици, които имат много редове и колони и е трудно да се ориентираме и да 
намерим необходимата ни информация. 

Важно е да знаем, че при сортирането, данните в таблицата не се 
променят, а само се пренареждат по зададения от нас ред. Важно изискване 
при сортирането на таблицата е да се внимава с това какво точно се сортира. 
Ако таблицата е пълна и няма липсваща информация (празни колони, редове, 
области от таблицата без данни или колони без наименования), е достатъчно 
да маркираме произволна клетка от колоната, която искаме да бъде критерий 

за сортирането и да натиснем бутона за преподреждане  . Excel автоматично 
ще маркира цялата таблица и ще сортира редовете по нарастваща стойност на 
избрания критерий (от по-малката към по-голямата стойност или от А към Я 
респективно от A към Z. Ако желаем да подредим таблицата в обратен ред, 

можем да използваме бутон . 
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Често обаче се налага да се сортират данни по няколко критерия 
едновременно. За целта трябва да се използва командата: Data → Sort. Тя 
също се „извиква”, когато сме маркирали клетка от таблицата или цялата 
таблица и показва на екрана прозореца Sort – фиг. 1.16. Настройките дават 
възможност да се зададат до три критерия на сортиране, като приоритетът се 
определя от поредността на задаването. Сортирането по командата 
представена на фиг. 1.17 ще се извърши, като най-напред се подреди 
таблицата по възходящ ред на колонка дата, а в рамките на една дата 
редовете ще бъдат подредени по номер на артикула. 

 
Фигура 1.16 Прозорец Sort. 

Ако в прозореца на фиг. 1.17 са разменени полетата: срещу Sort by е 
записано номер, а срещу Then by е записано дата, командата ще подреди 
таблицата по номера, а там където един и същ номер се среща на различни 
дати, там те ще бъдат подредени по дати. (фиг. 1.17)  

 
Фигура 1.17 Сортиране по два критерия. 

Excel позволява и подреждане по трети критерий, който се изпълнява 
там, където се срещат повече от един ред отговарящ и на двата критерия 
едновременно. Задаването на третия критерий става в третото поле на 
командата. 

Филтриране (Auto Filter) 

Филтрирането на данни в таблицата е друга възможност за обработка на 
информацията, която подпомага работата с големи масиви от данни и когато се 
налага да се извлече част от тях по определен критерий. Филтрирането е метод 
на представянето на информацията, който „скрива” част от данните (редовете 
от таблицата), които не отговарят на зададения критерий/ критерии. За разлика 
от сортирането, при което критериите се ограничават до 3 (виж фиг. 1.16), при 
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филтрирането всяка колонка от таблицата може да се използва като критерий. 
Това става чрез включване на командата за филтриране на таблицата: 

 Data → Filter →  . 
 Предварително е необходимо маркера да бъде в произволна клетка от 

таблицата или да бъде маркирана цялата таблица. В резултат, в десния долен 
ъгъл на всяка клетка от антетката на таблицата (виж фиг. 1.18.) се появява 
бутон . Този бутон  се използва за задаване на критерии за филтриране на 
данните. 

 
Фигура 1.18 

Филтриране на 
данните по 

критерий ‘дата’. 


